This introductory session focuses on finding references by starting with a keyword search.
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• In this session, you will gather background information for a hypothetical research
project to see how you can use SciFinder to answer some common research questions.
• First, you will design an effective search query and refine the results to identify the most
relevant answers.
• Then, you will use various SciFinder tools to find information to answer questions
related to the project.
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These materials are divided into three parts during which all of the questions get answered.
You will learn some techniques in each part and can practice at your convenience.
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In Part 1, you want to find the references that pertain to your search topic. You will learn
to:
• Create an effective keyword search
• Remove duplicate references that are found in both SciFinder databases
• Use the Refine feature to narrow an answer set
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• In this example, you want to find documents about methods used to clean up an oil spill
in the ocean.
• You will work with four concepts: clean up, oil spill, ocean and method.
• You will begin with a search query which contains three of these concepts and later use
the fourth concept to refine the answer set.
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• When you login to SciFinder, the Explore REFERENCES: RESEARCH TOPIC page is the
default. Here, you will create a keyword search to find references related to the topic of
your project.
• You can initiate a literature search with any of the REFERENCES options on the
left, or initiate a SUBSTANCES or REACTIONS search. Click the type of search and
the corresponding entry window will appear.
• Notice the SciFinder Help in the upper right corner. Click the drop down arrow to access
the online Help, Training (on the cas.org website), What’s New, and Contact Us.
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• To find references about your topic, start with a keyword search.
• The best initial searches include two or three concepts combined with prepositions.
• The prepositions are not part of the search results. They help SciFinder identify
the concepts you want to search.
• Tips for specifying research topics are available in the online help.
• To access help, either click the “?” in the blue circle or the SciFinder Help drop
down menu.
• Click Advanced Search if you want to narrow your search by additional criteria, such as
Publication Years and Document Types.
• Unless you are looking for a very specific document, it is generally
recommended that you begin with a broad search, and later refine your answer
set.
• All of the options available in the Advanced Search are also available later in
your SciFinder session.
• In this example, three concepts are combined with prepositions: clean up of oil spill in
ocean.
• You do not need to use truncation, also called wildcards, to retrieve alternate
word forms because SciFinder does it for you automatically.
• Click Search.
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• SciFinder separates the search query into concepts and then assembles a list of
candidate answers based on:
• Combinations of the concepts
• Their relationship to each other (whether they are closely associated with one
another or present anywhere in the reference)
• The identified concepts are in bold type.
• For the term “clean up”, the word “up” is ignored since it is so common.
• A useful answer set for further exploration is often one which contains all of the
concepts anywhere in the reference.
• All of the concepts closely associated with one another means that all three
concepts must appear in the same part of the record, such as the title, abstract
or a single index term. This answer set is useful if you want to work with a
smaller answer set of very relevant records.
• Select one or more of the candidates, and then click Get References to see the
reference answer set.
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• The answers are sorted by Accession Number, a unique record identifier that begins with the
year that the record was added to the database followed by a sequential number (e.g.,
2012:1200005).
• The blue arrow pointing down indicates that the most recent answers are displayed
first.
• If you want to see the oldest records first, click the arrow to reverse the sort order.
• Below the Sort by: options, you can see the number of references in the answer set.
• Click the box to left of the answer number to select it for saving, exporting or other
activities.
• Above your answers on the right side of the page are the Display Options link and the page
controls.
• Click the link to change the number of answers that appear on a page, as well as what is
displayed (no, partial or full abstract).
• Words that match the search criteria are highlighted in the title and bolded in the abstract.
• To save you time, SciFinder automatically recognizes and retrieves synonyms (e.g., marine and
sea for ocean) as well as related word forms (e.g., cleaning, clean and clean‐up for clean up).
• To the left of your reference answer set, you see Analyze and Refine tabs and a Categorize
button. You will work with those options later.
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• Above the toolbar, you see the steps taken in your search. This navigation path is also
called the “breadcrumb” trail. It tracks the history of your search.
• Place your mouse cursor over a breadcrumb entry to see a tool tip. The tool tip contains
information about that step.
• In this example, the tool tip shows you that the records come from two bibliographic
databases: CAplusSM and MEDLINE®.
• CAplus is the Chemical Abstracts Plus database. It is updated daily and more
then one million records are added to the database every year.
• MEDLINE is the MEDlars OnLINE database from the U.S. National Library of
Medicine.
• Some MEDLINE references are often duplicates of the references found in
CAplus, since common journals are included in both databases. MEDLINE does
not cover patents.
• You can easily remove the duplicate MEDLINE records.
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• Select Tools > Remove Duplicates to remove the duplicate MEDLINE references from the
answer set.
• Notice on this Tools menu that you could also Combine Answer Sets or Add Tag.
If you click either of these options , a dialog window appears. You can complete
the information in the dialog window if you want to take advantage of these
features. Consult the SciFinder Help for additional information.
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• The yellow status bar displays the number of duplicate records that were removed.
• You can set a SciFinder preference to automatically remove the MEDLINE duplicates
when a search is performed.
• Click Preferences in the status bar to view and edit them.
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• Check the box for Remove Duplicate References. SciFinder will automatically remove
the duplicate MEDLINE records when a search is conducted.
• This step is automatic on answer sets that contain up to 10,000 records.
• Other preference options are also available:
• Password and Account Information: This link opens the myCAS page where you
can change your SciFinder password and update your account information.
• When you click this link, you should automatically be logged into my
CAS.
• If auto‐login does not occur, use your SciFinder login ID and password.
• Keep Me Posted Notification: Keep Me Posted automatic alerts are addressed
later in this workbook. This preference tells SciFinder to send you an email
notification when new records related to your topic of interest are added to the
SciFinder databases.
• My Suppliers: You can manage preferred suppliers for chemical substances and
reactants.
• Starting Page: When you sign in, the Explore References page is displayed by
default. If you most frequently conduct substance or reaction searches, you can
select a different default starting page.
• Click OK to update your Preferences and return to your active session.
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• Since your answer set contains more than 500 records, you can use the fourth concept,
method, to both reduce the number of records and find answers that better meet the
needs of this hypothetical research project.
• Refine is a useful way to narrow the answer set by criteria that you specify.
• Select the Refine tab and then select a Refine by radio button. Text boxes for entering
criteria will appear below the radio button options.
• In this example, refine the current answer set by specifying additional Research Topic
criteria.
• Use the fourth concept, method, as the search criteria.
• To be sure that SciFinder looks for a synonymous term, process, type it and then
enclose it in parentheses. You could enter up to three synonyms in one set of
parentheses, separated by commas.
• You can also specify synonyms in your initial search, if desired.
• If you review your answers and notice that SciFinder did not automatically
include a synonym, you can revise your keyword query and rerun the search.
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• You now have a good answer set about your research topic.
• Both the original search terms and the refine terms are highlighted in the titles and
abstracts.
• In Parts 2 and 3, you will answer the remaining questions for this hypothetical research
project.
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In this session, you will learn to answer the questions:
• How can you automatically stay updated on this topic?
• Which references have been cited the most?
• How many patents are there?
You will also learn how to retrieve the full‐text of most patents.
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• Recall that SciFinder bibliographic content is updated daily.
• To easily stay up‐to‐date on the latest information on your topic, you can choose to
receive automatic notifications when new records related to your search topic are
available in SciFinder.
• A Keep Me Posted (KMP) can find new answers for a search on a weekly or
monthly basis.
• SciFinder will notify you when new records that meet your search criteria are
added to the database.
• If the Create Keep Me Posted Alert icon is not present or is grayed out, then you
have taken a step—such as an Analyze or Categorize—that precludes the
creation of a KMP.
• See SciFinder Help or contact CAS Customer Care (help@cas.org) if you need
assistance creating a KMP.
• Click the Create Keep Me Posted Alert icon to open the dialog window.
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• The yellow status message indicates that some steps, such as a sort, will not be part of the KMP
but you can still set up a KMP for your search.
• Enter a Title and optional Description.
• Specify the Duration. By default, the KMP will expire one year after its creation.
• To select a shorter duration, click Change.
• Select the Frequency. The KMP can be run each Week or each Month.
• By default, results will include previously retrieved references that have been updated since
they were originally retrieved. Check the box for Exclude previously retrieved references to
exclude these references.
• Bibliographic information from nine major patenting authorities is added to the
database within two days of a patent being issued. The scientific indexing is added
within 27 days of issuance. If you check this box, you will not see the indexing when it is
added to these patent records.
• In general, it is best to not check the box so that you see updates and errata.
• On the right, SciFinder tracks the Search Strategy of each answer set.
• Click Create to activate the KMP.
• The alert is set to run automatically and you are returned to your active session.
• Recall: To receive an e‐mail notification about the results when the KMP is executed,
you need to check the option Receive
e‐mail notification of Keep Me Posted results on the Preferences page.
• When you receive a notification, sign in to SciFinder to view the results.
• For more information, click the blue circle with the question mark to open the context‐specific
online SciFinder Help.
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• The online SciFinder Help provides detailed information.
• The help launches in a separate window or tab (based on your browser settings).
• When you are finished with the help, you can navigate back to your active SciFinder
session.
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• You can identify influential authors in this field two ways.
• One way: look at the Analyze tab to see which authors have published the most
documents.
• The top ten authors and the number of references attributed to them
are shown with analysis bars.
• To see the references attributed to a single author, click the blue bar
associated with the author’s name
• To see all of the authors, or to select references for more than one
name, click the Show More button (not shown).
• Another way: Sort by: Citing References to see whose publications have been
cited most frequently.
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• The answer set is sorted so that the most frequently cited references appear first.
• To see the references that cited a specific document, click the number and icon to the
right of the title.
• If you click the molecule icon, you will see a list of the substances which are
important to the science in the document.
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• One of the questions you want to answer is “how many patents are there?”
• Analyze makes it easy to answer the question and to narrow your answer set.
• To see how many patents are in your answer set, click the drop‐down arrow and select
Document Type.
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• The top ten document types and the number of references for each type are shown as
analysis bars.
• The document types shown in all capital letters (e.g., JOURNAL ARTICLE) are
from MEDLINE only.
• Click the Patent analysis bar to display only the patent references.
• Below the top navigation bar, SciFinder provides a yellow status bar. It confirms that only
the patent references are now displayed.
• Note, however, that the number of references in the answer set has not
changed.
• To return to the complete answer set, click Clear Analysis.
• To keep the patent references as the new answer set, click Keep Analysis.
• The Analyze feature is a useful way to learn more about your answer set. Since you can
clear an analysis after reviewing the results, you can explore the answer set several ways
before deciding how you want to narrow it.
• With Analyze you can preview the results before reducing the size of the answer set.
With Refine, the answer set is immediately narrowed based on the criteria that you
select.
• Since you want to look at patents as part of this project, select Keep Analysis.
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• The patents are now your answer set.
• PatentPakTM is a workflow solution that reduces time spent acquiring and
searching through multiple patents to find vital chemistry information.
• If your company has purchased PatentPak, you can click the drop down arrow to
access the PatentPak viewer and the PDF for many patent family members.
• To learn more about PatentPak, consult the SciFinder training page shown
earlier.
• Click a title to see the Reference Detail.
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• The Reference Detail page includes all of the available information for a document in
SciFinder.
• The top of the page includes:
• The bibliographic information, the abstract, and for patents, the Patent
Information table.
• The right‐side column provides summary information about the publication,
including dates and sources.
• The Indexing
• When CAS scientists create records for the CAplus database, the records are
assigned to one of eighty broad areas of scientific inquiry, known as the Section
title.
• CA Section Title is a useful way to analyze an answer set if you want to
focus on a particular type of chemistry.
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• The Indexing, continued
• Concepts are uniform, consistent index terms that serve as pointers to a topic.
Concepts are listed in blue boxes. When you identify concepts that apply to your
area of research, it is often useful to include those keywords in your search
query.
• The Substances column includes the CAS Registry NumberSM for the substances
that are important to the science of the document.
• For companies that have purchased PatentPak, you can click the page
number to launch the PatentPak Viewer and go immediately to the
substance’s location in a patent.
• The bottom part of the Reference Detail page includes:
• Supplementary Terms are keywords about the article that are not standardized.
They are often new terms associated with the leading edge of science.
• Tags are labels that you can add to a record or a set of answers (under Tools).
Since tags are searchable, they are a convenient way to group answers from
several different answer sets into one new answer set.
• You can also add Comments to records, if desired.
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• To further explore a reference in your answer set, on the Reference Detail toolbar, you
can click the Link to Other Sources button to see the available options for accessing the
original document.
• In this example, when you click Link to Other Sources, you are taken to the CAS Full
Text Options page and can then click Search to open the Espacenet web site. Click the
patent title and it is available to download.
• If your organization has subscriptions to journals, your SciFinder Key Contact can set up
access to the journals.
• Close the tab or window to navigate back to your active answer set.
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In Part 3, you will learn how to answer the remaining questions:
• What types of processes are patented?
• How can you keep these references for future use and also share them with colleagues?
• What chemical substances are part of the clean up processes?
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•
•
•
•

Use the breadcrumb trail to return to the patent answer set.
Next, you want to identify what processes have been patented.
You will use the Categorize feature to answer this question.
Click the Categorize button.
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• Just like the indexing at the back of a book, CAS scientists apply indexing to reference
records in the CAplus database.
• This indexing is standardized, controlled vocabulary. Therefore, it is a useful way for you
to identify references about indexed topics.
• You viewed some indexing in Part 2 when you looked at the Reference Detail for
a record.
• Indexing is applied for broad Category Headings, and then for more specific Categories,
and finally at the specific Index Term level.
• In this example, you can select the Technology Category Heading and then select
Processes & apparatus in the Category column to see all of the index terms about
cleaning up oil spills.
• Click the box beside specific Index Terms of interest to select them. Then click OK to
create an answer set made up of the references associated with the index term(s).
• This new step becomes part of your breadcrumb trail. You can always return to a
previous step in the breadcrumb trail by clicking that step.
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• The references associated with the processes you selected are now your answer set.
• You can click the magnifying glass next to a reference to see information about that
document in a separate window.
• This Quick View allows you to view the abstract, any Reference Images, and Substance
Images, when available, without leaving your active SciFinder session.
• Unlike the Reference Detail view, you will not see the indexing or all of the
source information.
• The Quick View can be useful for reading the entire abstract.
• Click the Substance Images tab to see the first fifty substances that are indexed in the
reference.
• Close the window to return to your active SciFinder session.
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• After you are satisfied with your answer set, you may want to download the information
into citation management software.
• Click Export to open the associated dialog window.
• In the Export window, specify the answers you want to export (All, Selected, or a
specific Range).
• Select a file format.
• For most citation software, the .ris file format is used. Check your citation
software for details. If a .txt format is required, you have both quoted and
tagged .txt format options.
• Other export options are also available, including .pdf, .rtf, or .txt for offline
review.
• Select Answer Keys, .akx, if you want to share an answer set with a colleague or
have the search extended in STN (another product that is available from CAS and
that provides access to many additional scientific databases).
• To open an answer key file, look in the Saved Answer Sets column of an
Explore page and click Import.
• Enter a File Name.
• Click Export. A standard File Download dialog window will appear. You can save the file
in the location of your choice.
• Depending on the browser you are using, the file may automatically be put into
your download file.
• If you have antivirus software, you may need to accept SciFinder as a trusted
source or temporarily allow downloads to use the Export feature.
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• After the windows close, you will again see your active SciFinder session.
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• To keep your answer set for future use, you can also save it to a CAS server.
• Click Save to open the Save This Answer Set window.
• Enter a Title and optional Description.
• For the Only selected answers option to be available, you would have had to
select some references by clicking the box to the left of answer number. When a
record is selected, a black checkmark appears in the box. Since no answers were
selected, this option is grayed out.
• You can re‐open a saved answer set at another time, on any computer, using SciFinder.
• Click OK to return to the active answer set.
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• Your saved answer sets and the associated search steps are displayed in the Saved
Answer Sets window.
• You can Edit or create a Link to your saved answer sets.
• Bibliographic answer sets are saved under the References tab. Substances and
Reactions answer sets are saved under their respective tabs.
• In addition, you can easily Combine Answer Sets in SciFinder.
• Click the box to the left of a title to select it.
• Select the two answer sets that you want to combine.
• The Combine Answer Sets icon at the top of the page becomes active.
• Four combine options are available. Select the option of interest and then click
Combine Answer Sets.
• This new answer set then becomes the active answer set.
• Combine is particularly useful if you want to merge two different answer sets or
when you have conducted two similar searches and want to see the records that
are unique in the larger answer set.
• Saved answer sets are retained until you delete them. To delete answer sets, select the
ones you want to delete and then click Delete Selected on the toolbar.
• In this example, you are not going to combine any answers, so use the breadcrumb trail
to return to your search results.
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• To retrieve all of the substances that are pertinent to the science in these references,
click Get Substances.
• Notice that you could also Get Reactions or Get Related Citations.
• In the Get Substances window, specify the substances of interest. By default, SciFinder
retrieves substances for All references.
• Click Get.
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• SciFinder retrieves the substances that are indexed in the records.
• Working with substance data is taught in the “Search for Substance Data” materials.
• You can use the breadcrumb trail to return to a previous step in your search or, on the
top navigation bar, click the Explore drop down arrow to initiate a new search.

37

This session is now concluded. To learn more about searching SciFinder, visit the training
page at cas.org or consult the online Help.
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